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@uzh_microscopy

> ZMB Quick Facts

Around 2.2h of image processing per 1h of microscopy



@uzh_microscopy

> Overview

• Brief intro image analysis

• ImageJ/Fiji

– Digital Image

– Display and visualization

– Histogram

– Segmentation, 
Thresholding 

– Analysis particles 
workflow and basic 
measurements



@uzh_microscopy

> FiJi Download FiJi

1. Download the appropriate Fiji
version from http://fiji.sc/

2. Unzip your copy to a location 
where you have writing rights. 
Otherwise, you will not be able to 
automatically install the latest 
updates.

3. Check if you have the latest updates 
by running Help>Update

4. Additionally add the “BIG-EPFL” 
update site. 

5. Click ‘Update URLs’ and ‘Apply 
changes’.

http://fiji.sc/

http://fiji.sc/
http://fiji.sc/


@uzh_microscopy

> Resources 

https://www.zmb.uzh.ch/en/Available-Systems/Image-processing/TutorialsAndResources0.html

https://www.zmb.uzh.ch/en/Available-Systems/Image-processing/TutorialsAndResources0.html


@uzh_microscopy

> Resources 

https://zmb.dozuki.com/c/Image_Analysis

https://zmb.dozuki.com/c/Image_Analysis


@uzh_microscopy

> Image Processing and Analysis

https://bioimagebook.github.io/index.html

https://bioimagebook.github.io/index.html


@uzh_microscopy

> Image Processing and Analysis

• Deriving quantitative information from images of 
biological samples taken with microscopes

How many cells 
are there in the 

outer ring?

How high is the 
intensity in the 

inner ring?

How is the signal in 
the blue channel 

distributed?

Image data source: Lorenzo Scipioni, U. California / Irvine
@LorenzoScipion3

Biological 
question



@uzh_microscopy

> Image Processing and Analysis

Automation



@uzh_microscopy [Arganda-Carreras, Andrey, 2017, https://doi.org/10.1007/978-1-4939-6810-7_13]

> Image Processing workflows

Biological 
question

Biological 
question



@uzh_microscopy

> Image Processing workflows

https://bioimagebook.github.io/chapters/0-preamble/preface/preface.html

https://bioimagebook.github.io/chapters/0-preamble/preface/preface.html
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> Introduction to Bioimage Analysis

Tools we use are
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https://commons.wikimedia.org/wiki/User:Acagastya


@uzh_microscopy

> Fiji: Image analysis

Trackmate

BigDataViewer

Core ImageJ

• Fiji is just ImageJ - with batteries included since 2005

TrakEM

Multiview fusion

1997 NIH Image ImageJ

Application

Reusable set of libraries

Shared framework for image analysis



@uzh_microscopy

> ImageJ, Fiji & friends: community

• Visit http://forum.image.sc !

http://forum.image.sc/


@uzh_microscopy

> FiJi (ImageJ)

FiJi (ImageJ)
Demo



@uzh_microscopy

> Fiji: user experience

• If you cannot find the command, 
– Use the search field!
– Press the “L” key and start typing in 

the search bar.

– It shows you where the plugin is 
located

– You can run it from here (enter)

Navigating through confusing menus

Additional plug-ins can be accessed through the update site
Help < Update

Enter

l

https://imagej.net/ij/docs/shortcuts.html

https://imagej.net/ij/docs/shortcuts.html


@uzh_microscopy

> Open an image – Bio formats

https://bio-formats.readthedocs.io/en/v7.3.0/supported-formats.html

https://bio-formats.readthedocs.io/en/v7.3.0/supported-formats.html


@uzh_microscopy

> Open an image – Bio formats

https://bio-formats.readthedocs.io/en/v7.3.0/formats/bitplane-imaris.html [2024 06]

File > Import > Image sequence

Really large data Memory managment

Virtual stack

https://bio-formats.readthedocs.io/en/v7.3.0/formats/bitplane-imaris.html


@uzh_microscopy

> FiJi: Opening images with FIJI

Image bit-
depth

Image size in  
pixels

Memory in 
hard drive



@uzh_microscopy

> Duplicate

ImageJ provides very limited 
Undo support for 2D slices

If you suspect you might regret 
a processing step, good practice 
to always duplicate the image 
beforehand with 

Hands-ON Chapter 8

Shift + D



@uzh_microscopy

> Duplicate



@uzh_microscopy

> Digital images: Matrices of  digital numbers

426 423 457 429 405 413 438 428 433 446 421 430 421 435 441 429 426 420 417 426 423 439 411 413 442 420 435 429 445 430 421 433 425 432

415 421 417 426 411 445 440 437 421 418 436 441 440 434 444 441 464 427 429 419 411 418 423 446 427 463 436 427 423 415 432 423 438 422

424 414 440 423 432 418 455 433 454 429 440 433 434 438 437 436 423 440 431 436 414 435 433 422 426 420 428 447 444 430 435 425 412 445

414 416 422 427 441 408 425 450 438 411 439 418 425 443 424 442 413 412 417 433 426 408 401 417 429 437 430 433 412 426 451 454 441 449

426 410 408 432 420 426 427 432 425 427 428 409 431 414 444 423 421 409 406 410 398 439 431 428 433 410 403 432 423 433 421 433 443 472

427 419 420 407 441 434 415 418 452 434 434 420 417 438 427 424 428 427 444 433 434 411 430 430 402 433 428 445 424 404 439 433 448 463

405 461 428 453 428 413 409 419 412 406 419 445 436 424 447 449 425 422 405 407 442 430 422 440 397 428 420 416 420 443 428 430 426 493

415 428 439 432 399 417 422 446 433 431 410 439 435 430 452 433 435 437 464 429 419 448 435 416 435 430 439 454 441 408 442 471 475 507

423 437 412 430 416 429 421 415 415 433 408 425 433 423 450 427 423 431 443 441 439 454 440 438 462 436 457 425 419 439 453 452 491 511

418 404 419 423 419 434 424 414 425 440 416 437 422 441 428 432 422 460 462 446 455 488 448 492 445 444 468 445 447 437 441 473 488 545

433 411 420 430 403 421 429 446 417 414 440 424 451 426 439 448 476 458 458 466 451 488 534 533 523 512 499 455 455 476 463 451 511 573

431 418 425 433 419 413 418 438 407 451 404 425 412 437 445 451 475 504 497 476 502 521 529 499 581 584 541 510 485 522 453 499 470 499

412 422 441 446 434 420 441 418 425 437 430 468 435 464 470 485 464 479 491 521 516 544 550 611 583 630 577 531 543 514 460 472 497 497

444 422 426 423 430 431 445 422 433 485 423 438 464 494 499 513 564 526 488 491 506 519 515 522 622 566 543 572 572 487 469 467 473 500

428 415 436 427 412 407 431 430 441 428 455 448 531 507 544 531 503 503 475 502 496 467 494 509 513 519 563 546 559 509 504 484 459 449

434 408 423 444 453 444 428 458 418 443 503 516 553 570 488 501 505 505 496 469 495 511 469 496 499 497 533 554 523 518 485 468 461 450

418 419 410 416 427 439 422 464 432 504 515 564 538 585 524 528 511 500 510 474 520 450 494 454 531 502 493 529 502 540 527 541 481 457

438 442 430 410 415 445 452 439 480 496 528 554 567 565 543 489 492 533 460 465 451 459 459 478 475 449 545 517 515 548 493 485 502 426

406 448 433 425 457 446 433 432 475 547 545 607 534 483 560 538 496 482 517 451 468 479 500 476 480 513 498 550 543 537 559 522 505 462

410 435 443 427 423 432 412 494 532 554 541 593 570 576 559 493 536 526 506 438 460 476 454 492 478 522 480 597 521 548 495 487 459 449

413 394 415 421 417 424 454 457 511 533 583 536 546 504 519 526 487 457 468 471 468 473 478 476 466 530 488 509 512 516 527 462 473 435

403 423 434 446 434 423 467 502 534 584 601 565 526 527 485 444 472 485 459 486 474 448 457 432 494 485 471 505 485 497 501 493 451 428

414 425 410 433 429 412 435 470 488 517 535 510 533 480 473 481 494 550 469 463 446 472 446 497 468 475 509 494 492 487 446 455 442 442

425 415 413 456 437 418 437 494 520 520 549 570 507 497 526 493 496 477 502 505 489 491 481 522 481 502 529 521 518 510 443 472 450 406

420 420 419 422 423 419 448 460 510 551 539 536 544 539 510 535 462 494 480 452 505 487 497 513 501 540 483 504 515 505 420 406 412 423

421 422 415 399 404 460 451 449 534 502 571 562 543 567 528 509 511 535 496 478 555 548 486 552 518 531 534 503 481 477 444 437 423 429

416 444 428 429 423 431 450 445 476 493 552 558 551 569 618 597 528 522 506 552 526 520 542 607 519 485 506 498 475 452 431 422 426 427

442 439 414 437 413 409 417 454 463 455 510 525 559 644 595 588 589 572 533 525 510 561 565 565 502 517 487 452 437 439 429 405 411 416

420 408 449 439 406 431 427 451 445 480 509 562 571 579 572 597 614 550 588 553 512 527 556 554 503 473 451 446 435 435 410 424 424 425

416 432 406 421 413 431 441 428 431 461 491 501 548 511 534 553 558 553 544 563 538 518 515 524 465 481 449 439 416 431 421 427 432 426

423 427 412 413 421 407 437 427 451 446 460 471 482 511 520 516 541 485 454 527 495 458 497 454 462 435 442 418 440 410 402 445 449 429

418 433 411 418 412 411 421 449 428 432 458 468 470 448 466 471 469 480 478 448 462 480 464 448 445 420 417 427 423 425 406 432 421 444

414 419 412 422 429 431 432 437 417 411 410 445 435 444 449 469 448 447 450 421 427 437 445 455 413 431 408 425 432 415 420 411 434 417

437 424 426 420 428 427 418 419 422 429 436 419 423 441 422 435 437 420 440 428 436 425 446 440 447 419 426 422 414 409 422 448 427 426

421 429 441 412 410 430 440 416 437 424 435 436 450 445 437 443 404 437 445 464 427 455 449 403 441 418 419 427 418 425 413 426 449 435

427 416 423 425 397 422 444 412 409 426 426 397 417 422 415 437 447 425 428 455 403 436 424 425 416 420 414 429 432 416 418 410 428 426

453 427 447 430 441 434 422 415 440 415 421 404 437 433 431 433 412 411 414 418 419 437 400 432 423 428 421 439 429 419 457 420 414 416

436 412 420 408 451 398 438 408 445 424 436 432 429 414 421 412 428 426 443 410 429 433 427 417 416 409 418 453 418 404 412 433 417 425



@uzh_microscopy

Image Histogram: Important tool to assess image properties and manipulations 
such as contrast, dynamic range, saturations, compression,…

> Distribution of  Intensity Values: Image Histogram



@uzh_microscopy

Linear Histogram

> Image Histogram

Live histogram as a tool to assess imaging quality: Which one is better?

Such image artifacts cannot be corrected by image 
processing! Make sure you acquire your images correctly!

Hands-ON Chapter 10



@uzh_microscopy

Adjusting look up tables (LUT)

A look up table (LUT) assigns each image 
intensity value a grey or color value. In 
imageJ various LUT`s can be selected.

> Visualization: Assigning Colors to Image Intensities

Applying a different lookup table doesn’t change the image. All pixel 
values stay the same, they are just displayed differently.

Hands-ON Chapter 11



@uzh_microscopy

> Visualization: Assigning Colors to Image Intensities

https://bioimagebook.github.io/chapters/1-concepts/2-measurements/measurements.html

https://bioimagebook.github.io/chapters/1-concepts/2-measurements/measurements.html


@uzh_microscopy

> Lookup tables

• Choose visualization of your color tables wisely!

• Think of people with red/green blindness!

Default view Red/green blind people see it like 
this

Replace red 
with magenta!

Adapted from https://f1000research.com/slides/10-934 

Color-blind friendly Palette

https://f1000research.com/slides/10-934


@uzh_microscopy

> FiJi (ImageJ)

FiJi (ImageJ)
Demo



@uzh_microscopy

>Macro language

Functions can require additional arguments. 

If the command being used by run requires extra information of its own, this is included as an extra string.

run("Duplicate...", "title=New_image.tif");



@uzh_microscopy

> Very short macro from this session



@uzh_microscopy

> Very short macro from this session

https://bioimagebook.github.io/chapters/2-processing/3-
thresholding/thresholding.html?highlight=otsu#thresholding-difficult-data

More on thresholding difficult data:

https://bioimagebook.github.io/chapters/2-processing/3-thresholding/thresholding.html?highlight=otsu#thresholding-difficult-data


@uzh_microscopy

Image Segmentation & Image Analysis

> Image Segmentation & Analysis



@uzh_microscopy

> Why Image Segmentation?

Sometimes boundaries are not complety obvious for the computer point of view…



@uzh_microscopy

Segmentation 
Partitioning of a digital image into multiple segments (Assign each pixel a label) 

Semantic segmentation – Differentiate pixels into classes. All instances have the same 
class

Instance segmentation – Differentiate individual occurrences within each class

> Image Segmentation and labelling
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> Semantic vs Instance Segmentation

https://www.nature.com/articles/s41540-020-00152-8
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Measurements in 2D: The Particle Analyzer

• Tell Fiji what to measure with Analyze > Set Measurements



@uzh_microscopy

> Lecture recap and next session

• Introduction to Bioimage 
analysis

• Introduction to ImageJ/Fiji

Demo

Next session…

• Automation and macros!

HANDS-ON



@uzh_microscopy

Thank you! Q&A


